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Abstract 

ORA is a network analysis tool that detects risks or vulnerabilities of an organizationôs design structure. 

The design structure of an organization is the relationship among its personnel, knowledge, resources, and 

tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as 

input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. 

ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are 

also organized by input requirements and by output. ORA generates formatted reports viewable on screen 

or in log files, and reads and writes networks in multiple data formats to be interoperable with existing 

network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for 

optimizing a networkôs design structure. ORA uses a Java interface for ease of use, and a C++ 

computational backend. The current version ORA1.2 software is available on the CASOS website: 

http://www.casos.ece.cmu.edu/projects/ORA/index.html.  
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Running ORA in Batch Mode  

January, 2010  
ORA Batch Mode XML  

Version 2.0.0  

I. Command Line Arguments  

The program ora.exe (henceforth called ORA) takes one or more of the following 
command line arguments as input: (1) Measures File to be used, (2) the Script File 

to use, and (3) the Log File to use.  

If you installed the front -end of ORA, then the executab le can be found as:  
[ORA installation directory] \ include \ OraFiles \ bin \ ora.exe  

Likewise, the Measures file can be found as:  

[ORA installation directory] \ include \ OraFiles \ xml \ ora_xml_measures.xml  

Measures File  

The Measures File is distributed with ORA and  contains an XML encoded description 
of all the measures available to ORA. This is distributed with ORA and is usually 

called ora_xml_measures.xml. The following command line parameter specifies the 
filename:  

-measures <filename>  

Script File  

The Script Fil e is an XML file created by the user and tells ORA where to load the 

input network data and which reports to generate. Section II -  ORA Script XML 
Specification -  describes in detail the format of this XML script. The following 
command line argument specif ies the filename:  

-script <filename>  

Log File  

The Log File is generated by ORA to record the progress and problems of ORA in 
processing the Script File. The log file is a text file, and the following command line 
argument specifies its filename:  

- log < filename>  

Help  
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A listing of the above parameters is available by using the following command line 
parameter:  

-help  

Version  

The ORA version can be obtained by the following command line parameter:  

- version  

II. XML Script  

The batch mode script is a user supp lied XML document that is input to ORA (see 
the -script command line parameter above). It tells ORA what network data to load 

and what reports to generate.  

Please note the following general guidelines for the script:  

1. camel case capitalization is used fo r element names: therefore element names 
begin lower case and the first letter of each word is capitalized. For example, Meta -

Network is metaNetwork.  

2. default values are used: therefore a short, simple script can initially be used to 
run ORA. Advanced us ers can change the default values.  

The root node is <ora>, which has two child elements <input> and <output>. The 

input element describes the network data to load, and the output section describes 
the reports to generate.  

Example: an empty script  
<ora>  

<i nput/>  
<output/>  

</ora>  

A. Input Section  

The main unit of input to ORA is the Meta -Network, and therefore the input section 
of the XML script tells ORA how to load one or more Meta -Networks. A Meta -

Network is simply an organization modeled as a collection of matrices. The entire 
Meta -Network can be loaded from a single data file, or each matrix can be loaded 
from separate data files with possibly different data formats.  

1. Meta - Network Specification  
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A Meta -Network is specified by the <Meta -Network> element . It accepts a single 
attribute called id which must be unique across all the Meta -Network elements.  

The child elements describe the location and format of its matrix data. There are 

two cases: (1) all data for the Meta -Network is stored in a single file,  (2) the data 
for matrices of the Meta -Network are located in separate files.  

1.1 Meta - Network data in a single file  

The first case is only possible for a data file in the DyNetML format. In this case, the 

<filename> and <format> children are required, and  the <properties> child is 
optional. The child elements are described below:  

filename : location of the data  

format : must by dynetml  
properties : [optional] Describes how ORA should interpret the data read from the 

file, but does not cause ORA to modify the input data in any way. Each graph in the 
Meta -Network is given the property.  

Properties are specified with the attributes below, each of which takes values: yes 
or no  

1.  sparse: indicates whether the data is sparse  

2.  binary: indicates whether the data shou ld be treated as binary (i.e. ignore 
edge weights)  

3.  symmetric: indicates whether the unimodal graphs should be considered 
symmetric  

4.  diagonal: indicates whether the diagonal values of unimodal graphs should 
be used  

Example:  

<Meta -Network id="Organization">  
< filename>data/organization.xml</filename>  

<format>dynetml</format>  
<properties binary="yes"/>  

</Meta -Network>  

1.2 Meta - Network data in multiple matrix files  

The second case has the Meta -Network data located in multiple files. In this case, 
the script must describe how to assemble the Meta -Network from different data 
files.  

Matrix data describes a relationship between two sets of nodes, called the source 
and target node sets. Therefore, in specifying a matrix, these nodesets must be 
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specified. A unique id f or the matrix is also specified. This id must be unique across 
all matrices in the Meta -Network.  

The <matrix> element defines a matrix and has the following case - insensitive 

attributes:  

sourceType : type of the source node set  
source : [optional] unique i dentifier of the source node set  

targetType : type of the target node set  
target : [optional] unique identifier of the target node set  

id : [optional] id of the matrix  

The above attributes can be any string.  

The sourceType and targetType attributes spec ify the class or general category of 
the node sets. By convention, these are taken from Agent, Knowledge, Resource, 

Task, Location, or Organization, but any string can be used.  

The source and target attributes uniquely identify the source and target node s ets, 
and if they are not specified the sourceType and targetType are used. To have more 
than one node set of a given type (e.g. "blue" agents and "red" agents), the source 

attribute must be used.  

The id uniquely identifies the matrix within the collection of matrices that is the 
Meta -Network. By default, the id is constructed from the source and target types.  

Examples:  

<matrix sourceType="agent" targetType="agent" id="reports to"/>  
<matrix sourceType="agent" source="employee" targetType="agent" 

target="empl oyee" id="works with"/>  
 
As in the first case, the <matrix> element must have the child elements 

<filename> and <format> that describe the location and format of the matrix data. 
The <properties> element is optional, and pertains only to the matrix.  

The <f ormat> element takes one of the following values:  

dynetml : DyNetML specified data  

ucinet : UCINET binary format (refer to UCINET documentation)  
dl : UCINET text format (refer to UCINET DL documentation)  

csv : CSV (Comma Separated Values) allows row and/or  column labels  
raw : space, comma, or semi -colon separated data (no labels allowed)  

Example:  
<Meta -Network id="SampleOrganization">  

<matrix sourceType="agent" targetType="agent" id="communication">  
<filename>data/organization_agent_agent.dl</filename>  
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<for mat>dl</format>  
</matrix>  

</Meta -Network>  

Multiple <matrix> elements are used to define the constituent matrices of the 
Meta -Network. Note that <Meta -Network> has no immediate <filename> and 

<format> children since the data is described under the <matrix> child elements.  
 

Example:  
<ora>  
<input>  

<Meta -Network id="SampleOrganization">  
<matrix sourceType="agent" targetType="agent" id="social">  

<filename>data/organization_agent_agent.dl</filename>  
<format>dl</format>  
</matrix>  

<matrix sourceType="agent" targetT ype="knowledge">  
<filename>data/organization_agent_knowledge.dl</filename>  

<format>dl</format>  
</matrix>  
</Meta -Network>  

</input>  
</ora>  

In the example, the Meta -Network contains two matrices: the first of type Agent x 

Agent and named social, and it is pop ulated with data from the specified file of the 
specified format. The second has type Agent x Knowledge, and no name is 
specified.  

1.3 Multiple Meta - Networks  

Multiple Meta -Networks can be specified in the <input> section using unique id 
attributes.  

Example : multiple Meta -Networks differentiated by id attribute  
<ora>  

<input>  
<Meta -Network id="SampleOrganization1">  

<matrix sourceType="agent" targetType="agent" id="social">  
<filename>data/organization_agent_agent.dl</filename>  

<format>dl</format>  
</matrix>  
<ma trix sourceType="agent" targetType="agent" id="friendship">  

<filename>data/organization_agent_agent_friend.csv</filename>  
<format>csv</format>  

</matrix>  
<matrix sourceType="agent" targetType="knowledge">  
<filename>data/organization_agent_knowledge</filenam e>  
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<format>ucinet</format>  
</matrix>  

</Meta -Network>  
<Meta -Network id="SampleOrganization2">  

<filename>data/organization2.xml</filename>  
<format>dynetml</format>  
</Meta -Network>  

</input>  
</ora>  

1.3 Meta - Network Directories  

If there are multiple DyNetML fil es in a single directory, then one can specify the 

directory and ORA will create a Meta -Network from each file. The <Meta -
NetworkDirectory> element is used, whose only attribute is name that specifies the 

path of the directory. Each file must have .xml ext ension. A <transform> element 
can be used within the element to apply to each Meta -Network. The id for each 
Meta -Network is its filename.  

Example: load all Meta -Networks from a directory  

<ora>  
<input>  

<Meta -NetworkDirectory name="data/sample/">  
<transform>  

<conform method="union"/>  
</transform>  
</Meta -NetworkDirectory>  

</input>  
</ora>  

B. Output Section  

The second section of the script file is the <output> element, and it describes which 

reports to generate. The reports available in ORA and how to specify th em in the 
ora -script is documented in the file ORA -batch -mode -parameters.xml, which is an 
XML specification in Relax -NG.  

Ora -Script Report Generation  
To tell ORA to create a report, the <reports> child element is used in the ora -script. 
The <reports> child  element contains a collection of <report> elements. Each 

report element specifies any input parameters, the output filename, and the output 
file type/format. Each <report> is uniquely identified by its id attribute.  

The <filename> child specifies the name  of the output file to create. The filename 

should NOT have an extension. The <formats> child contains one or more 
<format> children which specify the format of the report output.  

For each report, the possible formats are: text, html, csv, dynetml  
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Example:  generating a report in multiple output formats  
<report id="intelligence">  

<filename>reports/intelligence</filename>  
<formats>  

<format>text</format>  
<format>csv</csv>  
</formats>  

</report>  

Any report specific parameters are designated within the <parameters > child. The 
parameters for each report are documented in the file: ora_xml_measures.xml  

Example: specifying report parameters  

<report id="intelligence">  
<parameters>  

<numberOfKeyEntities>10</numberOfKeyEntities >  
</parameters>  
<filename>reports/intelligen ce</filename>  

<formats>  
<format>html</format>  

<format>csv</format>  
</formats>  
</report>  

Example: shorter script if only one output format is specified  
<report id="intelligence" filename="reports/intelligence" format="text">  
<parameters>  

<numberOfKeyEntitie s>10</numberOfKeyEntities >  
</parameters>  

</report>  

3. Saving Meta - Networks  

The input Meta -Networks can themselves be saved to files. This allows for 
converting between matrix formats and for saving transformed or conformed input 
data.  

Example: saving a sp ecific Meta -Network  
<ora>  
<output>  

<Meta -Networks>  
<Meta -Network id="sample">  

<filename>data/output/sample.xml</filename>  
<format>dynetml</format>  
</Meta -Network>  

</Meta -Networks>  
</output>  

</ora>  
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Only the specified Meta -Networks will be saved. Individual matrices can be saved 
using the syntax identical to that of the <matrix> element in the input section. The 

following, for example, saves the agent x agent matrix:  

Example: saving a specific matrix from a Meta -Network  
<ora>  

<output>  
<Meta -Networks>  

<Meta -Network id="sample">  
<matrix sourceType="agent" targetType="agent">  
<filename>data/output/sample_agent_agent.dl</filename>  

<format>dl</format>  
</matrix>  

</Meta -Network>  
</Meta -Networks>  
</output>  

</ora>  

In addition, network set operations (union, intersectio n, difference) can be 
performed on the input networks and then saved. The sample below assumes that 

there were two Meta -Networks specified in the <input> section, namely, A and B, 
and the set operations all pertain to them. Union and Intersect operate on o ne or 
more input Meta -Networks, and the parameter method indicates how to handle 

common edges. The method attribute takes on one of the following values: binary, 
sum, maximum, or minimum. The difference between two Meta -Networks is taken 

with respect to ed ges only, and thus no nodes are removed.  

Example: saving union of multiple input Meta -Networks  
<output>  

<Meta -Networks>  
<! -- Union -- >  
<Meta -Network id="A Union B">  

<filename>data/output/A -union -B.xml</filename>  
<format>dynetml</format>  

<union method="sum">  
<Meta -Network id="A"/>  
<Meta -Network id="B"/>  

</union>  
</Meta -Network>  

<! -- Intersect -- >  
<Meta -Network id="A Intersect B">  
<filename>data/output/A - intersect -B.xml</filename>  

<format>dynetml</format>  
<intersect method="minimum">  

<Meta -Network id="A"/>  
<Meta -Network id="B"/>  
</intersect>  

</Meta -Network>  
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<! -- Difference (edges only) -- >  
<Meta -Network id="A Minus B">  

<filename>data/output/A -minus -B.xml</filename>  
<format>dynetml</format>  

<difference>  
<Meta -Network id="A"/>  
<Meta -Network id="B"/>  

</difference>  
</Me ta -Network>  

</Meta -Networks>  
</output>  
</ora>  

4. Transform Element  

The transform element is used to pre -process a Meta -Network or an individual 
matrix of a Meta -Network before generating reports. It transforms its parent 
element. For example, if the <trans form> element is a child of a <matrix> then it 

applies to that matrix. If it is a child of <Meta -Network>, then it transforms the 
entire Meta -Network: for node set modifications (removeNodes, subsetNodes, 

conform), these apply to the Meta -Network as a whol e, but transformations of 
edges (symmetrizing, dichotomizing) are applied to each matrix independently.  
 

The <transform> element has the following child elements that define the 
transformation:  

<transpose> : transpose the graph  

<removeIsolates> : remove is olate nodes  

 
<removePendants> : remove pendant nodes  

<symmetrize method=òò> : symmetrize using one of two methods 

ñunionò : symmetrize using the union/maximum method 
ñintersectò : symmetrize using the intersect/minimum method 
Default is ñunionò. 

<subsetN odes> : defines a subset of nodes to create a subgraph  
contains one or more of the following child elements:  
<nodeSet type=òò/> : adds all nodes in the specified node set to the subset.  

 
The type attribute can have values: agent, knowledge, resource, task , organization  

<node type=òò id=òò radius=òò/> : adds the specified node to the subset 

The type attribute is identical to that of the <nodeSet> element.  
 
The id attribute is the nodeôs unique id within the node set. 
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The radius attribute is optional (by d efault it is zero), and includes all nodes within 
a distance <= radius of the node. This is useful for defining ego node sets.  

<removeNodes> : defines a subset of nodes to remove  

contains the same <nodeSet> and <node> child elements as subsetNodes  

<conform  method=""/> : creates an identical set of nodes across Meta -Networks. 
This is useful for time -series data to give each Meta -Network the same node sets. 

The union method adds isolates to achieve identical sets, and the intersect method 
removes nodes.  

The m ethod attribute can have one of two values:  

union: create union of node sets  
intersect: create intersection of node sets  
Default is "union".  

By default the agent, knowledge, resource, task, and organization node sets are 
conformed. This can be customized by adding <nodeSet> child elements to specify 
specific node sets, as in subsetNodes above.  

<dichotomize criteria="" cutoff=""/> : creates a binary graph according to the 

criteria and cutoff. Any edges whose value does not satisfy the criteria and cutoff 
are given a value of 0, otherwise a value of 1.  

 
The criteria attribute takes one of the following values:  
lessThan, lessThanEquals, equals, greaterThanEquals, greaterThan  

 
The cutoff attribute can be any numerical value.  

Precedence  

The order (i.e. precedenc e) in which the transformations occur is as follows: (1) 
individual matrices, (2) Meta -Networks, (3) across Meta -Networks. Each of these 

usages is in the examples below.  

The precedence of operations within a transform (for example, is the graph 
symmetrized  before dichotomizing, etc.) is defined to be the same as they are 
specified in the <transform> element. Thus, if the <symmetrize> child is before 

the <dichotomize> child, then the transformation first symmetrizes and then 
dichotomizes.  

Example: remove all  agent nodes and the specified knowledge nodes from the 

Meta -Network  
<Meta -Network id="test">  

<transform>  
<removeNodes>  
<nodeset id="agent"/>  

<node nodesetId="knowledge" id="physics"/>  
<node nodesetId="knowledge" id="mathematics "/>  
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</removeNodes>  
</transf orm>  

<filename>data/sample.xml</filename>  
<format>dynetml</format>  

</Meta -Network>  

Example: symmetrize a single matrix of the Meta -Network  
<Meta -Network id="test">  

<matrix sourceType="agent" targetType="agent">  
<filename>data/aa.csv</filename>  
<format>csv< /format>  

<transform>  
<symmetrize method="union"/>  

</transform>  
</matrix>  
<matrix sourceType="agent" targetType="knowledge">  

<filename>data/ak.csv</filename>  
<format>csv</format>  

</matrix>  
</Meta -Network>  

This example creates a sub -Meta -Network as follows: a set of nodes is defined, and 
then the Meta -Network induced by the nodes (that is, all the edges incident upon 

those nodes). The set of nodes consists of all nodes within distance 2 of agent Andy 
and within distance one of Sam. Because the transform is pa rt of the Meta -

Network, knowledge, task, or organization nodes can be connected to these agents, 
and would therefore be part of the set.  

Example: define a subset of nodes  

<Meta -Network id="test">  
<transform>  
<subsetNodes>  

<node nodesetId="agent" id="Andy" radius="2"/>  
<node nodesetId="agent" id="Sam" radius="1"/>  

</subsetNodes>  
</transform>  
<filename>/data/myorg.xml</filename>  

<format>dynetml</format>  
</Meta -Network>  

 

This example makes the agent nodes in the Meta -Networks conformable by creating 
the union of all the agent node sets across the Meta -Networks. Currently, only 
agent nodes can be made conformable.  

Example: conform nodesets across Meta -Networks  
<input>  
<transform>  
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<conform method="union"/>  
</transform>  

<Meta -Network id="org1">  
<filename>data/org1 .xml</filename>  

<format>dynetml</format>  
</Meta -Network>  
<Meta -Network id="org2">  

<filename>data/org2.xml</filename>  
<format>dynetml</format>  

</Meta -Network>  
<Meta -Network id="org3">  
<filename>data/org3.xml</filename>  

<format>dynetml</format>  
</Meta -Networ k>  

</input>  

 

Glossary  

A  | B  | C | D  | E | F | G | H  | I  | J | K | L  | M  | N  | O | P | Q | R | S | T | U  | V | 
W  | X | Y | Z  

A  | Top  

Action : driving to the mall, eating lunch. Used as a verb.  

Adjacency Matrix : A Matrix that is a square actor - by - actor (i=j) matrix where 
the presence of pair wise links are recorded as elements. The main diagonal, or 
self - tie  of an adjacency matrix is often ignored in network analysis.  

Aggregation : Combining statistics from different nodes to higher nodes.  

Algorithm : A finite list of well -defined instructions for accomplishing some task 

that, given an initial state, will terminate in a defined end -state.  

Agent : An agent, is an information processing entity that can take agent. The 
most common agents are p eople. For some research questions, however, it may be 

useful to make these agents decision entities characterized by role, e.g., registered 
nurse and doctor. For other research questions, it make make sense to treat the 

agents as decision making units, li ke alpha=unit. For other research, the agents 
might be specific animals, or robots, or other types of actors. Researchers disagree 
as to whether all agents in the same entity class should be at the same level, e.g., 

all people, or whether different levels can be mixed such as people and decision 
units. The key is that an agent is an actor that can act in isolation and is not, for 

the purpose of the resesrch, subdividable into parts nor has members.  
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Agent - Generic : Agent -generic are general classes of agents . These can represent 
the role or an attribute by which an agent is characterized. Examples include 

american, girl, child, nurse, president.  

Agent - Specific : Agent -specific are specific agents. They are generally names 
entities representing a unique actor.  Examples include George_Washington, 

Red_Deer_0001012.  

Asymmetric Networks : Asymmetric, also called Directed Networks, can have any 
number of links in and out of a node.  

Attribute : Indicates the presence, absence, or strength of a particular 

connection  between nodes in a Matrix. It can also be information about the 
specifics of the agents. These are usually traits that agents have in common, each 
can be slightly different (e.g. visible traits like hair colour or intangible traits like 

religious beliefs).  

B  | Top  

Betweenness : Degree an individual lies between other individuals in the network; 
the extent to which an node is directly connected only to those other nodes that are 

not directly connected to each other; an intermediary; liaisons; bridges. Therefo re, 
it's the number of nodes who an node is connected to indirectly through their direct 

links.  

Betweenness Centrality : High in betweenness but not degree centrality. This 
node connects disconnected groups, like a Go -between.  

Bimodal Ntwork : A network mo st commonly arising as a mixture of two different 

unimodal networks* .  

Binarize : Divides your data into two sets; zero or one . 

Binary Network : A binary network is constructed by binary values (either 1 or 0) 
in its network matrix and contains only the information whether a link between two 

entities in the network exists or not.  

Bipartite Graph : Also called a bigraph. It's a set of nodes decomposed into two 
disjoint sets such that no two nodes within the same set are adjacent.  

C | Top  

Caesar III : An ap plication for the design of information processing and decision 

making organizations. An application for the design of decision making 
organizations at the operational and tactical levels; it takes into consideration 
cultural differences in coalitions and of adversaries. This tool is under development 

by George Mason University.  
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Categorical : An Attribute Type used primarily used for grouping nodes.  

Centrality : The nearness of an node to all other nodes in a network. It displays 
the ability to access info rmation through links connecting other nodes. The 

closeness is the inverse of the sum of the shortest distances between each node 
and every other node in the network.  

Centralization : Indicates the distribution of connections in the employee 

communication network as the degree to which communication and/or information 
flow is centralized around a single agent or small group.  

Characteristic Path Length : The median of the average shortest distances 

(number of links) connecting each employee to all other empl oyees.  

Interpretation : Characteristic path length gives a insight into how information 
spreads. It reflects the communication performance of the entire network and is 

important for diffusing information and routing information to the right people. A 
smal l average path length results in fewer "hops" where individuals or groups 
don't get information.  

Classic SNA density : The number of links divided by the number of possible links 

not including self - reference. For a square matrix, this algorithm*  first conv erts the 
diagonal to 0, thereby ignoring self - reference (an node connecting to itself)  and 

then calculates the density. When there are N nodes, the denominator is 
(N*(N - 1)) . To consider the self - referential information use general density.  

Clique : A sub -structure that is defined as a set of nodes where every node is 

connected to every other node.  

Clique Count : The number of distinct cliques to which each node belongs.  

Closeness : node that is closest to all other nodes and has rapid access to all 
informat ion.  

Clustering coefficient : Used to determine whether or not a graph is a small -

world network.  

Cognitive Demand : Measures the total amount of effort expended by each agent 
to do its tasks.  

Column Degree : see Out Degree* . 

Complexity : Complexity reflects cohesiveness in the organization by comparing 

existing links to all possible links in all four networks (employee, task, 
knowledge and resource) .  
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Complementarity : The idea that people seek others with characteristics that are 
differen t from and complement their own, aka the idea that opposites attract.  

Concor Grouping : Concor recursively splits partitions and the user selects n 

splits. (n splits - > 2 n  groups) . At each split it divides the nodes based on 
maximum correlation in outgoing  connections. Helps find groups with similar roles 

in networks, even if dispersed.  

Congruence : The match between a particular organizational design and the 
organization's ability to carry out a task.  

Construct : A reduced form of Construct is found in ORA  in the Near Term 

Impact Report . 

Continuous : A Attribute Type primarily used for values that are numerical so that 
statistical analysis can be be performed (Average, Minimum, Maximum, and 

Standard Deviation).  

Count : The total of any part of a Meta -Networ k row, column, node, link, 
isolate, etc.  

CSV : File structure meaning Comma Separated Value . Common output structure 
used in database programs for formatting data.  

D  | Top  

Degree : The total number of links to other nodes in the network.  

Degree Centrality : a node with the most connections. (i.e. In the know) . 
Identifying the sources for intel helps in reducing information flow.  

Density :  

¶ Binary Network : The proportion of all possible links actually present in the 

Matrix.  

¶ Value Network :  The sum of the links divided by the number of possible 

links. (i.e. the ratio of the total link strength that is actually present 
to the total number of possible links) . 

Disconnected Network : If subsets of nodes are arranged in a way that all nodes 

of gr oup A are unreachable from all nodes from group B and vice versa, the 
network is disconnected. Therefore, there is no link connecting any pair of nodes 
between the subsets of nodes.  

Dyad : Two nodes and the connection between them.  
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Dyadic Analysis : Statis tical analysis where the data is in the form of ordered 
pairs or dyads. The dyads in such an analysis may or may not be for a network.  

Dynamic Network Analysis : Dynamic Network Analysis (DNA) is an emergent 

scientific field that brings together traditiona l Social Network Analysis*  (SNA), 
Link Analysis*  (LA) and multi -agent systems (MAS).  

DyNetML : DyNetML is an xml based interchange language for relational data 

including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal 
data interch ange format to enable exchange of rich social network data and 

improve compatibility of analysis and visualization tools.  

E | Top  

Edge : See Link . 

Eigenvector Centrality : Node most connected to other highly connected nodes. 
Assists in identifying those wh o can mobilize others  

Entity Class (same as Ontology class) : The group of nodes that exist in the 

same domain and are connected to one another. It's a simplified wat of viewing the 
information.  

Event : Something that happens, especially something of impor tance. Events are 

usually thought of as a public occasions but they can also be clandestine meetings. 
The number of agents can range in the thousands or as few as two agents (e.g. 
Christmas in Times Square or dinner with friends).  

Event - Generic : Something  that occurs periodically [i.e. Summer ]  

Event - Specific : One particular instance which may, or may not, be re -occuring. [ 
i.e. Christmas 2011 or the 9/11 attacks ].  

F | Top  

FOG : (F)uzzy (O)verlapping (G)roups. Gives a better understanding of individuals 
spanning groups. Fuzzy groups are a more natural and compelling way of thinking 

of human social groups.  

G | Top  

General density : The number of links divided by the number of possible links 
including self - reference. For a square matrix, this algorithm*  includes self -

reference (an node connecting to itself)  when it calculates the density. When 
there are N nodes, the denominator is (N*N). To ignore self - referential information 

use classic SNA*  density.  
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Geodesic Distance : A generalization of the notion of  a straight line  to curved 
spaces . In presence of a metric, geodesics are defined to be (locally) the shortest 

path between points on the space.  

Gini coefficient : The measure of inequality of a distribution of income. Uses a 
ratio with values between 0 an d 1: the numerator is the area between the Lorenz 

curve of the distribution and the uniform (perfect) distribution line; the 
denominator is the area under the uniform distribution line.  

Graph Level Metric : A metric defined for, and gives a value for, the network as a 

whole. The metric is calculated once for the network. Examples are 
Centralization, Graph Hierarchy, and the maximum or average 
Betweenness.  

GraphML : GraphML is a comprehensive and easy - to -use file format for graphs. It 

consists of a language core to describe the structural properties of a graph and a 
flexible extension mechanism to add application -specific data.  

Group : a collection of things (entities, nodes, ties, networks).    A group might at 

times be represented as a meta -node.    Nodes may  be classified in to groups on the 
basis of a shared attribute, type, id - range, label, user selection, etc.    For example, 

if you have a set of people and know their gender, then their might be two groups -  
men and women.    In addition the nodes representi ng those people could be 
displayed as a meta -node for men and a meta -node for women.    Nodes may be 

classified in to groups on the basis of a grouping algorithm.    For example, if you 
have a network showing connections among members of an organization and you 

run a grouping algorithm it will return clusters of nodes that fit together on some 
mathematical criteria.    This cluster is a group and can be represented as a meta -
node.  

H  | Top  

Hamming Distance : Number minimum number of substitutions required to 
change one string into another string of equal length. (i.e. " t on ed " and " r oses" is 
3.)  

Heidarian Balance : A motivational theory of attitude change proposed by Fritz 

Heider, which conceptualizes the consistency motive as a drive toward 
psychological balance . (Also known as Balance Theory)  

Heuristics : Problem -solving by trial and error: a method of solving a problem for 

which no formula exists, based on informal methods or experience, and employing 
a form of trial and error iteration.  

Homophily : (i.e., love  of the same) is the tendency of individuals to associate and 

bond with similar others.  
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¶ Status homophily  means that individuals with similar social status 
characteristics are more likely to associate with each other than by chance.  

¶ Value homophily  refers t o a tendency to associate with others who think in 
similar ways, regardless of differences in status.  

HTML : H yper Text Makup Language.  

I  | Top  

In - Degree : The sum of the connections leading to  an node from  other nodes. 
Sometimes referred to row degree . 

Influence network : A network of hypotheses regarding task performance, event 
happening and related efforts.  

Interstitial : An interstitial (something "in between") is a node situated within but 
not restricted to or characteristic of a particular group. It  provides extra information 
to the analysis.  

Isolate : any node which has no connections to any other node  

K  | Top  

Knowledge : Information learned such as a school lecture or knowledge learned 
from experience (e.g. Excellent knowledge of the periodic table  or "I know what you 
did last summer").  

L  | Top  

Latent Semantic Analysis : Latent semantic analysis (LSA) is a technique in 
natural language processing, in particular in vectorial semantics, of analyzing 
relationships between a set of documents and the ter ms they contain by producing 

a set of concepts related to the documents and terms.  

Lattice Network : A graph in which the links are placed at the integer coordinate 
points of the n -dimensional Euclidean space and each node connects to nodes 

which are exact ly one unit away from it.  

Link : The representation of the tie, connection, relation, link between two nodes.  

Link Analysis : A scientific area focused on the study of patterns emerging from 
dyadic observations. The relationships are typically a form of co-presence between 

two nodes. Also multiple dyads that may or may not form a network.  

Link Class : A set of Links of one type. A set of links of one type can be 
represented as a meta - link.  
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Location : An actual physical place. This could be a room in a bui lding, a city, or a 
country (e.g. Pittsburgh, PA or my living room).  

Location - Specific : A Named Entity which is a location [ i.e. The Empire State 

Building ].  

Location -Generic : A location without a specific reference [ i.e. a beach ].  

Lossy Intersection : Full intersection means that a node/link needs to be in 100% 
of the networks to be in the resulting network. Lossy intersection at X% percent 

means that a node/link needs to be in at least X% of the networks to be in the 
resulting network. Thus, Lossy in tersection is a generalization of full intersection.  

M  | Top  

Main Diagonal : in a square matrix this is the conjunction of the rows and cells for 

the same node.  

Math Terms  

These mathematical terms and symbols are used: Let S be any set:  

¶ card(S) = |S| = the  cardinality of S (the cardinality of the node -sets is 
represented as |A|, |K|, |R|, |T|)  

¶ ᴘ denotes a real number  

¶ Z denotes an integer  

Matrix Algebra : The part of algebra that deals with the theory of matrices.  

Measure : A measure is a function that maps one or more networks to R n. 
Measures are often scalar (n=1) or vector valued with n=|V| or n=|U|.  

Member Node : A node with a link to a meta -node.  

Meta - Link : The representation of a Group of Links.  

MetaMatrix : See Meta -Network  

Meta - Network : The represen tation of a Group of Networks.  

Meta - Node : A meta -node is a node composed of a set of member nodes. The 
member nodes may themselves be meta -nodes.  

Monte Carlo : A random optimization of your organization  
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MRQAP  -  This describes a report in ORA. See Reports  for more information. For 
multivariate cases, if your dependent variable is continous or count data (like in a 

negative binomial case), you should use MRQAP. If your dependent variable is 
binary, you should use ERGM (P*) which is forthcoming in ORA. One c an perform 

MRQAP on data that have a dichotomous dependent variable (basically, this is 
equivalent to using a linear probability model). You do need to interpret your 
results accordingly.  

Multi - Agent System : A loosely coupled network of problem -solver nod es that 
work together to find answers to problems that are beyond the individual 
capabilities or knowledge of each node  

Multi - node : More than one type of node (people, events, locations, etc.) . 

Multi - plex : Network where the links are from two or more rel ation classes.  

Multimode Network : Where the nodes are in two or more node classes.  

N  | Top  

Neighbors : nodes that share an immediate link to the node selected.  

Network : The representation of a set of nodes (including meta -nodes) of one type 
and the links  (including meta - links) of one type between them.  

A network N is a triple consisting of two sets of nodes, called U and V, and a set of 

links E ṒUxV. Thus, we write N=(U,V,E). An element e = (i,j) in E indicates a 

relationship or tie between nodes i Uɴ and j Vɴ. A network where U=V and therefore 

EṒVxV is called unimodal* ; otherwise the network is bimodal* . We write G=(V,E) 
for unimodal*  networks. For our purposes, unimodal networks will not contain self 

loops, which means that (i,i) Eɵ for i Vɴ.  

Network Class : A set of Networks on one type. This can also be represented as a 
Meta -Network.  

Network data format : usually comes in the form of NodeSet 1 listed vertically in 

column A starting in row 2 and NodeSet 2 listed horizontally in row 1 starting with 
column B. A ll the intersecting cells are the links between each of the nodes.  

Newman Grouping : Finds unusually dense clusters, even in large networks.  

Node : A representation of a real -world node (a who, what, where, how, why item.  

people, agents, organizations, bel iefs, expertise, resource, tasks, events, or 

locations. Node the representation of a single node (a who, what, where, how why 
item).  
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Node Class : A set of nodes of one type. Note a set of nodes of one type can be 
represented as a meta -node.  

Node - Generic : Generic entities are ones for which there are multiple 

instantiations; i.e., they represent a class.  

Node Level Metric : is one that is defined for, and gives a value for, each node in 
a network. If there are x nodes in a network, then the metric is calcul ated x times, 

once each for each node. Examples are Degree Centrality* , Betweenness* , and 
Cognitive Demand* . 

Node Set : See Meta -Node.  

Node - Specific : Specific entities are ones for which, within the bounds of the 

research project, there is exactly one ent ity that can be associated with that name.  

Normalized Sum : Otherwise known as the Average.  

Notation:  

The following matrix notation is used throughout the document for an arbitrary 
matrix X:  

¶ X(i,j) = the entry in the i th  row and j th  column of X  

¶ X(i,:) = i th  row vector of X  

¶ X(:,j) = j th  column vector of X  

¶ sum(X) = sum of the elements in X (also, X can be a row or column vector of 

a matrix)  

¶ dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff X(i,j) > 0  

¶ X' = the transpose of X  

¶ ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0  

¶ X@X = element -wise multiplication of two matrices (e.g. Z=X@Y => Z(i,j) = 
X(i,j)*Y(i,j))  

O | Top  

ODBC : (O)pen (D)ata (B)ase (C)onnectivity is an access method developed by the 

SQL Access group in 1992 whose goal was to make i t possible to access any data 
from any application, regardless of which database management system (DBMS)  is 

handling the data.  
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Ontology : "The Specifics of a Concept" . The group of nodes, resources, 
knowledge, and tasks that exist in the same domain and are connected to one 

another. It's a simplified way of viewing the information.  

Ontology Class (same as entity class) : The group of nodes that exist in the 
same domain and are connected to one another. It's a simplified wat of viewing the 

information.  

Org anization : A group of agents working together for a common cause (e.g. The 
Red Cross or the local chess club).  

Organization - Specific : A Named Entity which is an organization [ i.e. The Red 

Cross ].  

Organization -Generic : An organization without a specifi c reference [ ].  

Out - Degree : The sum of the connections leading out from  an node to  other 
nodes. This is a measure of how influential the node may be. Sometimes referred to 

as column degree . 

P | Top  

Pajek : A visual tool for analyzing large networks (netw orks having thousands of 
vertices).  

Path : A set of nodes and links that form a single unbroken chain, such that no 

node or link is repeated. i.e. A ᵼ B ᵼ C ᵼ D ᵼ E 

Pendant : Any node which is only connected by one link. They appear to dangle  
off the main group.  

Percolation Theory : The behavior of connected clusters in a random network.  

Pythia : Program used to create Influence Nets. Pythia is a timed influence net 

application. This tool can downloaded at the following URL: 
http://sysarch.gmu.edu/main/soft ware/ . 

Q | Top  

QAP Correlation : Calculates measures of nominal, ordinal, and interval 

association between the relations in two matrices, and uses quadratic assignment 
procedures to develop standard errors to test for the significance of association.  

QAP is designed as a bivariate test (only two variables). Generally, QAP is 

perfectly fine for almost any bivariate network problem.  

R | Top  
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Random Graph : One tries to prove the existence of graphs with certain properties 
by assigning random links to various nodes. The existence of a property on a 

random graph can be translated to the existence of the property on almost all 
graphs using the famous Szemerédi regularity lemma* .  

Reciprocity : The percentage of nodes in a graph that are bi -directional.  

Redundancy : Number of nodes that access to the same resources, are assigned 

the same task, or know the same knowledge. Redundancy occurs only  when more 
than one agent fits the condition.  

Regression Analysis : This is used to understand which among the independent 

va riables are related to the dependent variable, and to explore the forms of these 
relationships. In restricted circumstances, regression analysis can be used to infer 
causal relationships between the independent and dependent variables. The depend 

and the i ndependent variables can be either network measure or numerical 
attributes of nodes. Used in Visualization/Measure Charts  

Relation : The way in which nodes in one class relate to nodes in another class.  

Resource : Can be either a physical or intangible obj ect. Anything that can be used 

for the completion of a job. (e.g. Use a car to drive from point A to point B or use 
money from a bank account to fund something).  

Robustness : Two different definitions:  

¶ Networks : Concerned with the reliability (Kim & MÃ©d ard, 2004) and 

continued functioning of a network following an intervention. The robustness 
of a network is particularly relevant in communication - type and flow -oriented 

networks. The purpose for understanding robustness of a network has more 
of a manageme nt of the network connotation.  

¶ Measures : This meaning has more of a statistical connotation. Studying the 
robustness of a measure of a network can also be referred to as conducting a 
sensitivity analysis on the measure. In keeping with the terminology of the 

most - recently published research in this area, in lieu of using the term 
sensitivity, we too will use the robustness term, although the terms can be 

used interchangeably.  
A measure is robust if a slight perturbation in its input produces a 
slight chang e in its output.  

Role : An agents role can be defined as their job for their employer or the part they 

serve during an event.  

Row Degree : see In Degree* . 

S | Top  
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Scale - Free Network : Some nodes act as highly connected hubs (high 
degree) , although most nodes are of low degree. Scale - free networks' structure 

and dynamics are independent of the system's size N, the number of nodes the 
system has. A network that is scale - free will have the same properties no matter 

what the number of its nodes is.  

Self - Loop  : An node with a connection to itself.  

Self - Looped Network : A self - looped network has non -zero diagonal elements in 
the network matrix.  

Shapefile : The GIS Visualizer can view overlay a Meta -Network over a map. The 

map is a shapefile: a digital vector st orage format for storing geometric location 
and associated attribute information. A "shapefile" commonly refers to a collection 
of files with ".shp", ".shx", ".dbf", and other extensions on a common prefix name 

(e.g., "lakes.*"). For example, Shapefiles co uld represent water wells, rivers, and 
lakes, respectively. Each item may also have attributes that describe the items, 

such as the name or temperature.  

Simmelian Ties : Two nodes are Simmelian Tied  to one another if they are 
reciprocally and strongly tied  to each other and strongly tied to at least one third 

party in common. It's a tie embedded in closed triples.  

Simulated Annealing : A method of finding optimal values numerically. It's a 
search method as opposed to a gradient based algorithm. It chooses a  new point, 
and (for optimization) all uphill points are accepted while some downhill points are 

accepted depending on a probabilistic criteria.  

The term Simulated Annealing  draws its inspiration from metallurgy, where 
atoms within a metal are heated there by dislodging them from a metal's internal 

structure transforming the metal into another atomic state. In this way, your 
organization is heated  changing its components in the attempt to arrive at an 

optimized state.  

Slow Measures : As the name implies thes e measures generally take longer to 
run.  

Small - World Network : Small -World Networks will have sub -networks that are 
characterized by the presence of connections between almost any two nodes within 

them.  

Social Network Analysis : The term Social Network Analysis (or SNA) is used to 
refer to the analysis of any network such that all the nodes are of one type (e.g., 

all people, or all roles, or all organizations) , or at most two types (e.g., 
people and the groups they belong to) . 
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Sph ere of Influence : One node's direct relationship with one of it's neighbors as 
a function of specified path length.  

Standard Deviation : The square root of the variance where variance is the 

average of the squared differences between data points.  

.stl fil e format : This file format is native to the stereolithography CAD software 
created by 3D Systems. STL files describe only the surface geometry of a three 

dimensional object without any representation of color, texture or other common 
CAD model attributes and can us both ASCII and binary representations  

Symmetric Networks  : Any link in a network will have a reciprocal link If there's 

a link from A to B then there will also be a link from B to A . Symmetric 
Network have symmetric values about its diagonal.  

Sz emerédi's Regularity Lemma : A fundamental structural result in extremal 

graph theory due to Szemerédi (1978). The regularity lemma essentially says that 
every graph can be well -approximated by the union of a constant number of 
random - like bipartite graphs , called regular pairs.  

T | Top  

Table data format : Table data usually contains a column with referencing IDs and 

headers denoting column names.  

Task : A task is part of a set of actions which accomplish a job, problem or 
assignment. Task is a synonym for activity although the latter carries a connotation 

of being possibly longer duration (e.g.)  

Tie : see Link  

Time : Referring to time or circumstances. Can be as broad as a year or as pinpoint 
as the exact time of a particular day (e.g. Last year or 2:33 PM on March 1st, 

2009).  

Topology : The study of the arrangement or mapping of the elements (links, 
nodes, etc.) of a network, especially the physical (real) and logical (virtual) 

interconnections between nodes.  

Total Degree Centrality : The normalized sum of an node's row and column 
degrees.  

Trail : A set of nodes and links that form a single unbroken chain that can revisit 

nodes but not links. i.e. A ᵼ B ᵼ C ᵼ A ᵼ D  

Transpose : In linear algebra, the transpose of a matrix A is another matrix A T 
(also written Atr , tA, or A') created by any one of the following equivalent actions:  
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¶ write the rows of A as the columns of A T 

¶ write the columns of A as the rows of A T 

¶ reflect A by its main diagonal (which starts from the top left) to obtain A T 

See The Transpose Wikipedia Entry  for formulas, examples and more 

information.  

Tuple : An ordered list of elements. Therefore n - tuple  is an ordered list of n 
elements. There is also a 0 - tuple  which is an empty sequence.  

U  | Top  

Unimodal networks : These are also called squa re networks because their 

adjacency matrix*  is square; the diagonal is zero diagonal because there are no 
self - loops* . 

W  | Top  

Walk : A set of nodes and links that form a single unbroken chain that can revisit 

both nodes and links. i.e. A ᵼ B ᵼ C ᵼ B ᵼ D .  

Weighted Network : If the weights of the links are different we use the term 
weighted network. Every link will be represented by a real number running 

continuously from -Ð to +Ð. 

 

Getting Started  

Welcome to ORA's Help File system! The ORA Help and examples contained herein 
are written with a specific data set in mind, mostly designed specifically for a 
particular section.  

How to use ORA help  

If you are not familiar with Social Network Analysis  we encourage you to read 

through the beginning sections of the help set. The ORA help set is broken up into 
seven primary parts, which are designed for varying levels of user expertise.  

Getting Started : Provides an overview of Social Networks and how they pertain to 

ORA. 

General Content : Information that appl ies to many parts of ORA in many 
different ways.  
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The Main Interface : Details working with the data within the Networks. This 
includes loading, saving, merging, performing various math functions on the 

Networks, generating a variety of networks, and runnin g reports.  

The Visualizer : Takes these Meta -Networks and turns them into graphical 
representations. There are tools for creating / deleting nodes and links, displaying 

information in different formats, and helping to analyze the data.  

GeoSpatial/Loom : Describes the parts of ORA specically designed with location 
functions.  

Measures : Explains the various measures used in ORA. They contain a short 

explanation. It also describes the type, input, and output . 

Reports : Contains a description of what each repor t is and what it will tell you 
about your data.  

Lessons : Designed to teach specific functions and how to carry out many types of 

useful network analytical tasks that can be accomplished by using ORA.  

 

What is ORA?  

An Overview  

The Organizational Risk Analyzer  (ORA) is a statistical analysis package for 
analyzing complex systems as Dynamic Social Networks .  

Many complex systems such as organizations, intra -state alliances, food webs, etc. 
can be represented as an ecology of interlinked networks. Within ORA any complex 

system is represented as a Network. What follows is a general description of ORA's 
primary capabilities. Specific instruction is provided under the correlating folders in 

this help system.  

See Basic Terms  for additional definitions relating  to Social Networks.  

The ORA Visualizer  

The ORA Visualizer renders conceptual images of social networks. Nodes such as 
Agents, Task, Knowledge and Organizations  represent real -world Entities  like 

the president of a company, driving to the airport, or how to wash your clothes. 
Nodes which share the same attributes can be further grouped together creating 

Meta -Node. Links  connect nodes that share a direct relationship. Such relationships 
are de rived from the Network . ORA's single unit of data input, and are referred to 
as graphs. The ORA visualizer is interactive. You can zoom, rotate, isolate, add 

and remove Meta - Nodes , and much more.  
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Reports  

ORA can run many reports: Risk, Intelligence, and Sphere of Influence  to 
name a few. Multiple organizations can be compared against each other, network 

structure can be optimized, subgroups within a network can be identified, and 
scenarios involving the removal of nodes or links can be examined. Reporting  

capabilities are constantly being refined and updated.  

Charts  

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and Heat 
Map . Each one in turn presents a different statistical profile of a selected nodeset. 

Examples of these reports and how to access them can be found under Basic 
Usages.  

 

Overview  

Contact Information  

Kathleen M. Carley  
CASOS, Carnegie Mellon University  

kathleen.carley@cs.cmu.edu  
tel: 412 268 6016  
ORA 

ORA is an analysis tool designed to help the user evaluate one or more  networks. It 
can be used to assess the nature of, features of, change in, and determinants of 

complex networks. A large variety of networks can be assessed including, but not 
limited to, social networks, activity networks, task networks, knowledge network s, 
supply chains, and communication networks. Using ORA questions such as the 

following can be addressed: what is critical, are there groups of interest, are there 
patterns of interest, how might interventions impact the network, who is critical, 

are there  emerging groups, how is the network changing.  

What is a network? In any data there are relations among things such as two 
people are cousins, or a set of people are all members of the same club. These 
networks might be psychological or cultural as when two people share the same 

belief. They might be physical as in two resources being in the same location or two 
computers being connected by a line, or they might be social as in people being 

related. There are many reasons why networks exist. Networks are ubiquitous. 
Everyone and everything is constrained and enabled by the networks in which they 
are embedded. Everyone and everything is embedded in multiple networks; e.g. 

you are connected to some people due to work, others due to school, others due to 
your  kids, and so on. ORA lets you visualize, assess, and reason about these 

networks.  
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What kinds of networks?  

ORA can assess any type of network. Anything that can be represented as a set of 
nodes and relations can be assessed. Typical networks are: social ne tworks (who 

interacts with whom), financial networks (who lends money to whom); gant charts 
(what task needs to be done before what), supply chains (what resources are 

needed to build what other resources)., semantic networks (what ideas are linked 
to what  ideas), proximity networks (what states border on what states), and so on. 

ORA can assess any data that can be represented as nodes and relations regardless 
of what the nodes are or what the relations are.  

What if there are many networks?  

ORA can be used to assess the interlocks among networks. For examples, imagine 
that the following networks exist: who works with whom; who has what skills, what 

skills are needed for what tasks, who is doing what tasks then ORA can assess 
whether in fact the right people have been assigned to those tasks or where there 

are problems because there is insufficient skills available for the task. ORA can 
assess "multi -mode multi - link" data.  

What if the networks change?  

ORA can be used to assess change in networks over time. Ove r time, the shape or 

topology of a network might change; e.g., start up companies move from a 
collaborative to a hierarchical structure, terrorists change what weapons they use 
to attack sites, scholars cite different papers, and so on. Consequently, over time, 

who or what is critical in a network might change. ORA can assess change in 
networks, and forecast possible ways in which the network might change in the 

future.  

What if information is incomplete?  

ORA can assess networks even when information is inco mplete. ORA has been built 
to gracefully degrade so that it calculates all and only those metrics for which there 

is information.  

Illustrative applications  

ORA has been applied in numerous settings. Examples include the following. 
Assessment of team -x lead ership structure at NASA. Comparison of terror 

networks. Identification of vulnerabilities in insurgency and terror networks. 
Assessing change in political elite structures in Korea and early identification of 
emergent leaders. Designing teams for wargames . Assessing the impact of turnover 

and retirement on public health organizations in Duchess County, NY. Identifying 
reports with AIS data. Organizations where ORA has been used include: AFIT, 

SOCOM, USMA, CIA, many universities.  



 

31 
 

Tool Evolution  

There are st ill many challenges in the area of dynamic network analysis. Key 
challenges include handling streaming data, locating confidence intervals for 

metrics, uncertainty assessment, and so on. As these challenges are met, new 
algorithms are implemented, tested a nd added to ORA thus further meeting the 

user's needs.  

 

Social Network Analysis (SNA)  

Social Network Analysis  is a scientific area focused on the study of relations, 
often defined as social networks.  

In its basic form, a social network is a network where the people entities  and the 
relations links  are a form of connection such as friendship. Social Network Analysis 

takes graph theoretic ideas and applies them to the social world.  

The term social netwo rk  was first coined in 1954 by J. A. Barnes (see: Class and 
Committees in a Norwegian Island Parish) . Social network analysis is also 

called network analysis, structural analysis, and the study of human relations. SNA 
is often referred to as the science of  connecting the dots . 

Today, the term Social Network Analysis (or SNA)  is used to refer to the 

analysis of any network such that all the entities are of one type (e.g., all 
people, or all roles, or all organizations) , or at most two types (e.g., 
people and  the groups they belong to) . The metrics and tools in this area, 

since they are based on the mathematics of graph theory, are applicable 
regardless of the type of nodes in the network or the reason for the connections.  

For most researchers, the entities ar e actors. As such, a network can be a cell of 

terrorists, employees of global company or simply a group of friends. However, 
entities are not limited to actors. A series of computers that interact with each 

other or a group of interconnected libraries can comprise a network also.  

Where to find out more on SNA  

¶ Scott, John , 2000, Social Networks, Sage (2nd edition)  

¶ Wasserman, S. & K. Faust , 1994, Social Network Analysis: Methods and 

Applications  
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Dynamic Network Analysis  

Dynamic Network Analysis (DNA)*  is an emergent scientific field that brings 
together traditional social network analysis (SNA) , link analysis (LA)  and 

multi - agent systems (MAS)* . There are two aspects of this field. The first is the 
statistical analysis of DNA data. The second is the ut ilization of simulation to 
address issues of network dynamics. DNA networks vary from traditional social 

networks in that are larger dynamic multi -mode, multi -plex networks, and may 
contain varying levels of uncertainty.  

DNA statistical tools are generally  optimized for large -scale networks and admit the 

analysis of multiple networks simultaneously in which, there are multiple types of 
nodes (multi - nodes)*  and multiple types of links (multi - plex)* . In contrast, SNA 

statistical tools focus on single or at mo st two mode data and facilitate the analysis 
of only one type of link at a time.  

DNA statistical tools tend to provide more measures to the user, because they have 
measures that use data drawn from multiple networks simultaneously. From a 

computer simulati on perspective, nodes in DNA are like atoms in quantum theory, 
nodes can be, though need not be, treated as probabilistic.  

Whereas nodes in a traditional SNA model are static, nodes in a DNA model have 

the ability to learn. Properties change over time; en tities can adapt: A company's 
employees can learn new skills and increase their value to the network; Or, kill one 

terrorist and three more are forced to improvise. Change propagates from one 
entity to the next and so on. DNA adds the critical element of a  network's evolution 
and considers the circumstances under which change is likely to occur.  

Adequate Survey Response Rate  

Often people try to get 100% response when the full network is collected -  

however, anything above 85% -90% is considered good. For ego  network data -  
standard response rate guidelines are followed.  

Where to learn to more:  

Kathleen M. Carley , 2003, Dynamic Network Analysisò in Dynamic Social Network 

Modeling and Analysis: Workshop Summary and Papers , Ronald Breiger, 
Kathleen Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, 

National Research Council, National Research Council. Pp. 133 -145, 
Washington, DC.  

Kathleen M. Carley , 2002, Smart Agents and Organizations of the Futureò The 

Handbook of New Media . Edited by Leah Lievr ouw and Sonia Livingstone, Ch. 
12, pp. 206 -220, Thousand Oaks, CA, Sage.  



 

33 
 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat , 2005 -
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, 

DSS Special Issue on Cyberinfrastructu re for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems.  

 

ORA and DNA  

In general, you may want to use ORA in conjunction with other computational tools 

to advance DNA theory. The CMU CASOS tools  that work with OR A to form tool 
chains are AutoMap  (extracts networks from texts) and various DNA simulators 
including both Construct and DyNet . These tools are often used in a number of 

real world applications, including the following areas:  

¶ Designing adaptive teams for C ommand and Control Networks  

¶ Estimating the impact of organizational downsizing  

¶ Estimating the effectiveness of new structures  

¶ Evaluating risk in organizational designs  

¶ Examine impact of IT effectiveness  

¶ Impact analysis of actions in asymmetric warfare simulation  

¶ Impact analysis of weaponized biological attacks on cities  

ORA is interoperable with a number of other SNA and link -analysis tools: UCINET, 

KeyPlayer, and Analyst Notebook . Additional information is listed under data 
import and export.  

Where to learn more about CASOS tools and this tool chain:  

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat , 2004, An 

Integrated Approach to the Collection and Analysis of Network Data , In Proceedings 
of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M.Carley , 2004, Estimating Vulnerabilities in Large Covert Networks Using 

Multi -Level Data , In Proceedings of the NAACSOS 2004 Conference, Pittsburgh, PA  

Kathleen M. Carley , 2003, Dynamic Network Analysis in Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers , Ronald Breiger, Kathleen 
Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, National 

Research Council, National Research Council. Pp. 133 -145, Washington, DC.  

Kathleen M. Carley, Jana Diesner, Jeffrey R eminga, Maksim Tsvetovat , 2005 -
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS 
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Special Issue on Cyberinfrastructure for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems . 

CASOS: Center for  Computational Analysis of Social and Organizational Systems 

(http://www.casos.cs.cmu.edu/index.html)  

 

System Requirements  

ORA performs best on machines that meet or exceed the following specifications:  

Spec  Windows  Mac (running XP)  

System  XP OSX 10.4.x  

RAM 256 MB  1GB  

Processor  Pentium 4  Intel Core 2 Duo  

Speed  1.0 GHz  2.0 GHz  

Java  6.0  6.0  

Extra    Parallels for Dual Booting  

NOTE : When working with extremely large data sets, increasing processing speed 
and RAM is highly recommended.  

 

Files Formats  

ORA can read in a multitude of file formats. Below is a list, with examples of the 

code, of those formats.  

DyNetML  ï .dl  ï UCINET  ï comma delimited (.csv)  ï text files (.txt)  ï Pajek 
(.net)  ï GraphML  ï GMU model (.stl)  ï Pathfinder (.lo) . 

DyNetML (the nat ive ORA xml format): DyNetML is an xml based interchange 

language for relational data including nodes, ties, and the attributes of nodes and 
ties. DyNetML is a universal data interchange format to enable exchange of rich 
social network data and improve compatibility of analysis and visualization tools.  

<node id="col_jack_o'neill">  
  <properties>  
    <property name="ally" type="string" value="yes"/>  
    <property name="gender" type="string" value="male"/>  
  </properties>  



 

35 
 

</node>  

<graph sourceType="Agent" source="Agent" targetType="Agent" 
target="Agent" id="agent x agent" isDirected="true">  
  <edge source="A01" target="A11" type="double" value="1"/>  
  <edge source="A02" target="A01" type="double" value="1"/>  
</graph>  

 

.dl: DL (for "data language") is a very powerful and (fairly) simple language that 
allows the creation of quite complex and large UCINET data sets with minimal data 

entry. DL language files are plain ASCII text files that can be created with any 
editor (be sure to store the results as plain  text).  

dl n=9, format=edgelist1  
labels:  

    A,B,C,D,E,F,G,H,I  
data:  
    1    1    1 
    1    2    1 
    1    6    1 
          .  
          .  
          .  
    8    7    1 
    9    9    1 

 

.##h and ##d (UCINet): UCINET datasets are stored in a special (Pasca l) 
format, but can be created and manipulated using both UCINET's and other 
software tools (text editors and spreadsheets). Each UCINET dataset consists of two 

separate files that contain header information (e.g. myfile.##h) and the data lines 
(e.g. myfile .##d). Because of this somewhat unusual way of storing data, it is best 
to create data sets with the internal spreadsheet editor or DL language tools, or to 

import text or spreadsheet files and save the results as UCINET files.  

 

.CSV (comma separated valu es): The CSV ("Comma Separated Value") file 
format is often used to exchange data between disparate applications. The file 

format, as it is used in Microsoft Excel, has become a pseudo standard throughout 
the industry, even among non -Microsoft platforms. F ile most commonly created 

from an Excel spreadsheet using the Save Asé option  

¶ Each record is one lineé but ð A record separator may consist of a line feed 
(ASCII/LF=0x0A), or a carriage return and line feed pair (ASCII/CRLF=0x0D 

0x0A)é but ð fields may con tain embedded line -breaks (see below) so a 
record may span more than one line.  

¶ Fields are separated with commas.  
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¶ Leading and trailing space -characters adjacent to comma field separators are 
ignored.  

¶ Fields with embedded commas must be delimited with double -quote 
characters.  

¶ Fields that contain double quote characters must be surrounded by double -
quotes, and the embedded double -quotes must each be represented by a 

pair of consecutive double quotes.  

¶ A field that contains embedded line -breaks must be surrounde d by double -

quotes  

¶ Fields with leading or trailing spaces must be delimited with double -quote 

characters.  

¶ Fields may always be delimited with double quotes.  

¶ The first record in a CSV file may be a header record containing column 
(field) names  

,A01,A02,A03,A04  
A01,0,0,0,0  
A02,1,0,0,0  
A03,1,0,0,0  
A04,1,0,0,0  

 

.txt (text files): Otherwise referred to ASCII files  which contain no 
extemporaneous formating.  

 

.raw:  

 

.net (Pajek): The file format accepted by Pajek provides information on the 
vertic es, arcs (directed edges), and undirected edges. A short example showing the 

file format is given below:  

*Vertices 3  
1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown  

2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown  
3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown  
*Arcs  
1 2 3 c Green  
2 3 5 c Black  
*Edges  
1 3 4 c Green  
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.graphml: GraphML is a comprehensive and easy - to -use file format for graphs. It 
consists of a language core to describe the structural properties of a graph and a 

flexible extension mechanism to add application -specific data. Unlike many other 
file formats for graphs, GraphML does not use a custom syntax. Instead, it is based 

on XML and hence ideally suited as a common denominator for all kinds of services 
generating, archiving, or processing graphs.  

<xs:annotation>  
  <xs :documentation  
    source="http://graphml.graphdrawing.org/"  
    xml:lang="en">  
    Simple type definitions for the new graph attributes.  
  </xs:documentation>  
</xs:annotation>  

 

.stl (GMU model): This file format is native to the stereolithography CAD software 
created by 3D Systems. STL files describe only the surface geometry of a three 

dimensional object without any representation of color, texture or other common 
CAD model attributes and can us both ASCII and binary representations  

An ASCII STL file begins with the line:  
solid {name}  
where name is an optional string. The file continues with any number 
of triangles, each represented as follows:  
facet normal n1 n2 n3  
  outer loop  
    vertex v11 v12 v13  
    vertex v21 v22 v23  
    vertex v31 v32 v33  

  end loop  
endfacet  
where n1 - n3 and v11 - v33 are floating point numbers in sign -
mantissa'e' - sign - exponent format and concludes with:  
endsolid {name}  

 

.lo (pathfinder):  

 

Network Drives  

If you are running on a network drive then the help system needs a drive letter in 
order to work correctly. There are 2 possible solutions to this:  

1.  Copy the ORA folder to each local machine.  

2.  If at all possible Map a Network Drive. Right click on the shared folder and 

select Map Network drive.  
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Mapping a Network Drive  

In an Explo rer window select My Network Places . Find the name of the network 
which contains ORA.  

 

Go back to My Document . 

 

From the menu select Tools ᵼ Map Network Drive . This brings up the dialog box 

below.  

 

Select the [Browse]  button in order to select the netwo rk drive.  
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Select the correct network drive and press [OK] . 

 

Select [Finish] . 
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Your computer now has the Network drive with ORA mapped on the desktop.  

 

DyNetML Networks  

DyNetML  

DyNetML  is an xml based interchange language for relational data including nodes, 
ties, and the attributes of nodes and ties. DyNetML is a universal data interchange 

format to enable exchange of rich social network data and improve compatibility of 
analysis and v isualization tools  

Uni - Modal Networks  

Uni -modal networks are not changed (e.g. an AA does is NOT symmetrized), but bi -

modal networks are symmetrized  in that the links from two or more networks are 
combined using the maximum method.  

Bi - Modal Networks  

Bi-mod al networks are combined. e.g., if there is an AK and a KA network, then the 

KA is transposed to AK2 and then AK and AK2 are unioned with the Maximum link 
weight from each (a,k) or (k,a) being used.  

Network names are normalized to have IDs agent x agent, a gent x knowledge, etc..  
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ORA QuickStart  

1.0 GENERAL  

1.1 WHAT IS ORA:  

ORA is a network analysis package that helps the user enter, analyze, visualize, and 

forecast changes in networks using graph based and statistical based techniques.  

ORA consists of two  parts: The Editor, which allows you to work on loaded Meta -
Networks and the Visualizer, which allows you to see a graphic depiction of the 

Meta -Network.  

1.2 INSTALLATION:  

This is the procedure to install ORA on your computer:  

Go to http://casos.cs.cmu.edu /projects/ora/software.php  

Click the Download  link  

Select the [ Yes  ] button to agree to terms and click [ Continue  ]  

Insert your Information and click [ Continue  ]  

Choose your platform.  

Click the link for your system [ 32 - bit or 64 - bit  ]  

After the program  is downloaded double click the ORA icon to install. Follow 

installation instructions.  

 

QuickStart Editor  

2.0 EDITOR  

2.1 EDITOR GUI  

The ORA interface is organized into three sections which are placed in resizable and 

dockable panes. Each pane will have one or more individual parts. On each tab are 
two buttons: undock and close . In the upper right corner of each pane are three 
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buttons: undock, maximize, and close . This will allow you to arrange the 
interface to suit your needs.  

 

fig -  The ORA Editor Interface  

1) Menu  ï Source for performing the majority of tasks. The Menu Items are 
separated into categories each with their own functions . 

2) Toolbar  ï Buttons for main functions to work with Meta -Networks, NodeClasses 

and Networks.  

3) Toolbar Button Adder  ï Allows you to add menu functions to the toolbar.  

4) Meta - Network Manager  ï This pane displays all currently open Meta -
Networks.  

5) Edi tor  ï This pane displays in multiple tabs information on Node Classes and 

Networks.  

6) Reports  ï This pane display reports run on Meta -Networks.  

2.2 WHAT ôS IN A META- NETWORK:  
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Meta - Network  ï A representation of a Group of Networks.  

Node  ï A representation of a real -world item (a who, what, where, how, why 
item).  

Node Class  ï A set of nodes of one type.  

Link  ï A representation of a tie, edge, connection, or relation link between any two 
nodes.  

Network  ï A representation of a set of nodes ( including meta -nodes) of one type 

and the links (including meta - links) of one type between them.  

Attribute  ï Additional information about a node. The most common agent 
attributes are age & gender although it can be anything you choose.  

2.3 META - NETWOKS, NO DECLASSES, AND NETWORKS BUTTONS  

ORA contains tools to Add or Remove Meta - Networks, NodeClasses, or 

Networks . The Plus  sign denotes adding and the Minus  sign denotes removing.  

 

To add a Meta - Network, NodeClass, or Network  click the appropriate button. 

The new item will appear in the Meta -Network Manager.  

To remove a Meta - Network, NodeClass, or Network  highlight the item and click 
the appropriate button.  

NOTE : When in the actual program only the applicable buttons will be active e.g. if 

a network is highlighted then only the Network buttons are active. All others would 
be greyed out.  

2.4 CREATING A NETWORK AND NODECLASS FILE  

A NodeClass or Network can be created either in ORA or in an external program 

such as a text editor [NotePad or NotePad++] or a spreadsheet program [Excel].  

Using a Text Editor  

To create a Network in a Text Editor all information will be separated by commas. 
The lefthand column consists of the FROM  nodes and the top row consists of the 
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TO  nodes. A ñ"0" ò at an intersection means the re is no link while a non -zero 
number  means there is a connection.  

,A01,A02,A03,A04,A05  

A01,0,0,0,0,1  

A02,1,0,0,0,0  

A03,1,0,0,0,1  

A04,1,0,0,0,1  

A05,0,0,0,0,0  

In the text file above notice the empty value  in the top row just to the left of the 

top comma. Th is corresponds to the empty cell in the Excel spreadsheet Column 
Aï- Row 1 .  

To create csv files save them as a text file (.txt) but change the extension name to 
.csv . 

Using Excel  

In an Excel Spreadsheet  you would place each set of nodes in a separate row o r 
columns with each piece of information in a separate intersecting cell. To create a 

csv file select File > Save As é... and save it as a comma -delimited file.  

 

Excel with the SG -1 Network data  
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Links will run from the node in Column A  to the node in Row 1 . For example there 
is a link from A02 > A01 [cell B3] but there is no link from A01 > A02 [cell C2].  

Again note that the cell [A1]  is blank. This is common in all network files created in 

this manner.  

2.5 IMPORT CSV FILES INTO ORA TO CREATE NODECLASS AND NETWOR:  

 With NodeClasse and Network created it is time to import them into ORA. For 
this we use the Data Import Wizard.  

Select Import existing data? > Table Data from Excel of delimited formats > 

Rectangle of link weights (a Matrix) . Click [ Next >  ].  

Click Create a new neta - network with ID:  

Replace Meta Network  with the name for your new MetaNetwork then click [ Next 
>  ]  

The Import Data Interface  

Click [ Browse  ] and locate the csv file of the agents.  

Set Source type  and Target type  to agent.  

NOTE : For this Network both are set to agent. Depending on the data you are 
importing these may be set to different nodeclasses.  

NOTE : Clicking on the Click to import from another file  allows you to import 
additional networks.  

Click [ Finish  ]  

To import additional  files into the Meta -Network choose Add to the existing 
meta - network  instead of Create a new Meta - Network with ID: . Then select 
the Meta -Network to add.  

 

The ORA Editor with the SG -1 network loaded  
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2.6 CREATING A NODE TITLE/ATTRIBUTE FILE  

CSV files are us ed to create NodeClass and Network files. These can be created in 
either a text editor or a spreadsheet program.  

In a Text Editor  you would place each node on a separate line with all information 
separated by commas. To create csv files same them as a text  file (.txt) but change 
the extension name to .csv. For this example the file will create Node Titles. This 

could be used to import any attribute. The top row contains the names of the fields 
that will be imported.  

id,title  

A01,col_jack_o ôneill 

A02,maj_sam antha_carter  

A03,daniel_jackson  

A04,teal ôc 

A05,gen_hammond  

In an Excel Spreadsheet  place each node name or attribute into a separate row 

with each piece of information in a separate cell. The juxtaposition of the various 
cells on a row code the relations of interest To create csv files Save As é... a 

comma -delimited file.  

In a Text Editor  place each node on a separate line. Save as a text file with the 
.csv externsion.  

NOTE : Only rows with ids which match up to existing nodes will be imported 

unless the Create new nodes option is checked.  

2.7 IMPORT ATTRIBUTES INTO ORA:  

Select Impo rt existing data? > Table Data from Excel of delimited formats > 
Simple Table > Node Attributes . Click [ Next  > ].  

Select the Meta -Network to add information. Click [ Next  >].  

Click Browse  and navigate to your attribute file.  

Select from the drop down whic h column to use to identify your node IDs.  

For each column a box will appear allowing you to chose which attributes to import. 

Place a check mark next to each attribute you want and give it a Type: Text 
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Category, Text, URI, Number Category, Number, or Date . An attribute without a 
check mark will not be imported.  

Select the NodeClass to add the attributes. This drop down will contain multiple 

entries if your Meta -Network contains more than one NodeClass.  

Click [ Finish  ].  

The A01, A02, etc will be replaced  with the titles in the attribute file.  

NOTE : Only the attributes you check mark will be imported. All others will be 

ignored.  

2.8 ADD/REMOVE NODES IN THE EDITOR:  

Nodes can be added or removed to any NodeClass through the Editor. Highlight the 
NodeClass t hen use the buttons on the right side of the Editor to manipulate the 
nodes. Some of the functions require that you place a check mark next to the node 

you are working with [i.e. deleting a node].  

Create: Insert new nodes into meta -network  

Move : Move node (s) from one node set to another.  

Delete : Remove node from NodeClass  

Merge : Combine two or more nodes into one  

Clean : Condense all references of one person into a single node.  

2.9 CHANGE DISPLAY TO BINARY OR NUMERICAL  

The grids in the Editor can display  link data as numeric or check marks. Binary data 

is usually done with check marks as it is simply on or off. Numerical data [for 
weighted links] can show a ink as 0 of a positive/negative number.  

Click Display Options  near the bottom right of the Editor i nterface.  

Select Binary link values  to display data as check marks.  

Select Numeric link values  to display data as numbers.  

2.10 ADD/REMOVE LINKS IN THE EDITOR TAB [BINARY]  

Click the [ Options é ] button in the lower right of the Editor.  

Highlight a Network  in the Meta -Network panel  
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Select the Editor Tab . 

In the grid find the intersection of the column node and row node.  

To create a link  place a check mark  in the cell. This can be done by clicking the 

box of pressing the spacebar while the cell is active.  

To remove a link  deselect a cell by removing the check mark . 

2.11 ADD/REMOVE LINKS IN THE EDITOR TAB [NUMERICAL]  

Highlight a Network  

Select the Editor Tab . 

In the grid find the intersection of the column node and row node.  

To create a link  place a non -zero number  in the cell.  

To remove a link  place a [ 0  ] in the cell.  

2.12 SAVE A META - NETWORK  

It is important to save your work from time to time. If something happens to your 

computer or ORA then all work done since your last save will be lost. You have two 
options.  

File > Save Meta - Network : Saves your work to the file that was originally open.  

File > Save Meta - Network As é... : Saves your work to a new file. Give the file a 

new file name when ORA asks. This can be useful if you are experimenting with 
different  ideas and do not want to affect your original data.  

2.13 PREFERENCES  

Every user will have their own way they want ORA to perform. The preferences 

allow for tweaking those functions. There are many parameters that can be set but 
the important ones to a new  user are listed for the individual tabs.  

General : Preferences for the look and feel of ORA such as whether tooltips are 
shown when hovering over items and the size of the toolbar icons.  

Data Sets : As a new user concentrate on the three radio buttons nea r the bottom. 

These allow you to specify what files you want to load whenever you restart ORA. 
To start make sure it is set to Restore previously loaded workspace files at 

startup . This can be changed as you learn more about the workings of ORA.  



 

49 
 

NOTE : Reports and Custom Reports are for advanced users.  

 

QuickStart Visualizer  

3.0 VISUALIZER  

3.1 VISUALIZER GUI:  

Contains the visual representation of your Meta -Network.  

 

The ORA Visualizer Interface  

1) Menu : Source for performing the majority of tasks.  



 

50 
 

2) Toolbars : Main functions for working with displayed Meta -Network.  

3) Zoom/Hyperbolic selector : Select the radio button for the either the sizing or 
fish -eye view  

4) Zoom/Hyperbolic controller : Controls degree of function.  

5) Toolbar Button Adder ï:Allows you to add menu functions to the toolbar.  

3.2 DISPLAYING META - NETWORK IN EDITOR:  

Meta -Networks can be visualized in many ways.  

Highlight a Meta -Network. Note we are back in the main ORA interface, not the 
Visualizer.  

Click the Visualizer button.  

Or from the Editor Menu select Visualizations > View Networks > 2D 

Visualization . 

NOTE : The Visualizations menu also contains other display functions for your 
Meta -Networks. Many of which are advanced functions.  

3.3 ADD/REMOVE NODES WITH THE VISUALIZER ME NUS:  

Actions > Add Node(s) : Allows you to add nodes to existing or new NodeClasses.  

Tools > Node Status : Displays all the information about the selected node.  

Tools > Node Locator : Selecting a node from the dialog box will reveal the 
location of the nod e in Visualizer.  

Display > Node Shaper : Use this tool to change the size and shape of the 
selected node.  

3.4 ADD NODE IN VISUALIZER WITH NODE CREATOR  

 The Node Creator  button is in the left toolbar. NOTE : [2] on The ORA 

Visualizer interface.  

In the drop  down menu select a NodeClass . 

Place a check mark  in the box. ORA will ask for a name for each new node  

Click in the Visualizer to create a new node.  
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3.5 ADD LINKS IN VISUALIZER WITH LINK CREATOR  

 The Link Creator  button in the left toolbar. NOTE : [2] on  The ORA Visualizer 

interface.  

Select the Network  from the dropdown menu to add a link.  

Select the weight for new links created.  

Click and hold on the source node . 

Drag the mouse to the target node  

Release the mouse to create a new link.  

3.6 REMOVE NODES O R LINKS IN VISUALZER WITH LINK ERASER  

 Click Node/Link Eraser  is in the left toolbar. NOTE : [2] on The ORA 

Visualizer interface.  

Removes node(s) and link(s) from the Visualizer display. Click on a node or a link  
to remove it from the display and Meta -Net work.  

If the Permanently Delete  check box is empty ORA will remove the node(s) ro 

link(s) from the display only. The node(s) or links(s) will be retained in the Meta -
Network.  

If the Permanently Delete  check box contains a check mark the node(s) or 
links(s) will be permanently deleted from the Meta -Network as well.  

3.7 SHOW/HIDE VISUALIZER LABELS, LINKS, & ARROWS:  

In the display various items can be shown or hidden. NOTE : [2] on The ORA 
Visualizer inte rface.  

 Toggles the display to show/hide  the node titles.  

 Toggles the display to show/hide  the links.  

 Toggles the display to show/hide  the node arrows.  

3.8 CHANGE NODECLASS COLOR:  

You can change the color of an entire NodeClass in the Visualizer.  
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If the Legend  is not visible, open it by selecting Tools > Legend . 

Click on the color node for a NodelClass.  

In the color selector dialog box select a new color.  

Click [ OK  ].  

3.9 DATA REDUCTION STRATEGIES  

At times the Visualizer display can be difficult t o read. There are multiple ways to 

reduce unneeded information temporarily from the display.  

3.9.1 HIDE ISOLATES  

You can remove Isolates from the display without permanently removing them from 
the Meta -Network.  

From the Visualizer menu select Actions > Iso lates > Hide Isolate Nodes . 

3.9.2 REMOVE ISOLATES  

You can permantly remove Isolates from a Meta -Network in two ways:  

From the Visualizer menu select Actions > Delete Isolates > Delete Currently 
Visible Isolates . This will remove from the Meta -Network only those nodes that 
are visible.  

From the Visualizer menu select Actions > Delete Isolates > Delete Underlying 

Isolates . This will remove all Isolates from the Meta -Network.  

3.9.3 HIDE PENDANTS  

You can remove Pendants from the display without permanently remo ving them 
from the Meta -Network.  

From the Visualizer menu select Actions > Hide Pendant Nodes . 

3.10 ADD ICONS OR PICTURES  

Nodes can be replaced by icons or pictures [50 x 50 pixel max] for easier 
identification.  

Icons  

Right -Click a node and select Appearan ce Submenu > Set Picture . 
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From the drop down menu select a category then click and highlight your icon.  

Click [ OK  ] when finished, The node will then display the icon  

3.11 CHANGE SIZE/COLOR NODES BY METRIC  

Display > Node Appearance > Size Node by Attribute or Measure . 

This will scale the size of all nodes by using the attribute or measure selected.  

Numbers for each node value are user adjustable.  

Display > Node Appearance > Node Color > Color Node by Attribute or 

Measure  

This will color all nodes b y using the attribute or measure selected.  

Colors for each node value is adjustable.  

To reset color and size select Display > Node Appearance > Reset Color and 
Size . 

 

QuickStart Reports  

4.0 REPORTS  

Reports give you information about your Meta -Networks. These are the four most 
important reports. The other reports are more specialized.  

Key Entity : Identifies key entities and groups who, by virtue of their position in 

the network, are critical to its operation.  

Networks : agent x agent, agent x knowledge, agent x resource, agent x task, 
agent x event, agent x location, all knowledge networks, any resource networks, 

task x event, task x task.  

Standard Social Network Analysis : Calculates the standard network analysis 
measures.  

Networks : Any square Network [ i.e. agent x agent].  

Sphere of Influence : For each individual, identifies the set of actors, groups, 

knowledge, resources, etc. that influence, and are influenced, by that actor.  
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Networks : agent x agent, agent x knowledge, agent x resource, agent x task,  
agent x location.  

Locate Sub -Groups : Identifies the subgroups present in the network using 

various grouping algorithms. Most algorithms only work on a single network at a 
time.  

Networks : Networks selected by the user.  

These reports are run from the Edit or menu.  

From the menu select Analysis > Generate Report > [ type in name of 
specific report] . 

In the searchbox at top type in the name of the report.  

You can type in the entire name or select the report from the drop down menu.  

Place a check mark next to the Meta -Networks to process and click [ Next >  ].  

Place a check mark next to the NodeClasses and Networks to process. Click the box 

to remove unwanted check marks.  

Select the number of nodes to display and click [ Next >  ].  

Select the location to save the  files and the filename for the report and click [ 
Finish  ].  

The reports will open in the Report tab of the editor in a text format. They will also 

open your browser and display with animated graphics.  

4.1 FOCUS ON ACTOR  

One item you need to discover is wh o is important in a Meta -Network. To obtain 
this information you can run the Key Entity report . Go to Analysis > Generate 

Reports > Locate Key Entities > Key Entity . 
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The report will ask you for the number of nodes to display and if you want to use a 
part icular attribute in the calculation. But the most important selection is the Who, 

How, What, and Where . When focusing on actors place a check mark in the Who 
only . By default the report lists the top 10. This can be changed when running the 

report.  

To find  out how a particular person is connected run the Analysis > Generate 
Reports > Locate Key Entities > Sphere of Influence  report.  
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Begin with placing a check mark next to one or more a Meta -Networks from the list. 

Then click [ Next >  ].  

In the second wind ow place a check mark next to the NodeClass(es)  to analyze. 
In this case choose Agent . 

All networks which contain any of the NodeClasses selected appear in the bottom 

pane. Having only choosen Agent  only the Agent x Agent  Network appears. Place 
a check mar k next to Agent x Agent . Then click [ Next >  ].  
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Next place a check mark next to the agent(s) to track. Then click [ Next >  ].  

Finally place a check mark next to all the nodes to visualize. Then click [ Next >  ].  

 




























































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































